Publication-Ready (RAMS-CD) Paper Preparation Instructions
Jane S. Doe, PhD, PE, University of Metropolis
Robert J. Lumice, Jr., PhD, Logical Solutions
Key Words: final paper preparation, format instructions, Proceedings
SUMMARY & CONCLUSIONS
Before preparing any paper for inclusion in the
Proceedings of the Annual Reliability and Maintainability
Symposium (RAMS Proceedings), read this entire document.
In order to ensure uniformity of appearance of the papers
included in the RAMS Proceedings, standardized organization
and formatting are defined in these instructions. The person
who actually prepares the “CD-ready” final version of the
paper must comply with the format instructions. The
document you are reading has been prepared using the
instructions and may be used as a template for paper
preparation.
Note that the management committee of the Symposium
does not take the responsibility for modifying any part of your
paper. Thus, failure to comply fully with these formatting
instructions can result in the elimination of your paper from
the Symposium program. Please also note that there have
been some changes in the format requirements for 2015 and
these instructions have been expanded to reflect the changes as
well as be more complete.
To ensure that all formatting contained in this template is
not changed during the preparation of the paper for submittal,
please do the following within Microsoft Word (See Figure 1):
Select the “Tools” Menu at the top of the page.
Select “Options” from the drop down menu.
Select the “View” tab.
Check “All” under Formatting marks.
This will display all of the formatting characters, i.e.,
paragraph marks, tabs, section breaks, etc. This will help you
understand how the template works and facilitate putting your
paper into the template.
If you have a question concerning the format rules,
contact the Program Committee Vice Chair responsible for
your paper. If the question is still not resolved, then contact
Joel A. Nachlas, RAMS Proceedings Committee Chair, by email at nachlas@vt.edu.
1 INTRODUCTION
The management committee of the Annual Reliability and
Maintainability Symposium (RAMS) is proud of the
appearance and technical quality of its Proceedings [1]. The
committee considers that format compliance contributes to the
usefulness of the paper contents by Proceedings readers.
These instructions [2] will help you prepare your final version

of your paper so that it can be included in the Proceedings.
Please follow them carefully. They are short, clear, and easy
to read.

Figure 1 - Select “All” to Show Formatting Marks
Please take special note of the fact that these instructions
are new. They are significantly changed from earlier versions
to facilitate the 100% paperless process that has been
implemented. Important changes include the use of Microsoft
Word Styles specific to RAMS with built-in line spacing, the
elimination of A4 Paper format, and elimination of LaTeX as
a submittal medium.
Other changes include definitive
guidance on preparing papers using this template. The
requirements of these instructions are MANDATORY.
Your paper is required to be submitted electronically. To
satisfy RAMS Proceedings requirements, every paper must be
prepared using Microsoft WORD software. The most recent
version of WORD available to you is preferred.
Times New Roman font is to be used throughout the

paper.
2 FORMAT & COMPOSITION
These instructions have been prepared according to the
requirements contained herein using the RAMS 2015
Template and specially designed RAMS Styles in Microsoft
Word. It is easy to see the correct form merely by looking at
this document. The general layout of all pages is identical and
is straightforward to establish using the “page setup” feature in
WORD. Dimensions and other layout information are defined
in inches. The following page dimensions are defined here for
ordinary 8-1/2 x 11 inch paper. As papers are submitted
electronically, A4 Paper format will no longer be accepted.
Margins are set using “Page Setup” in the “File” pull-down
menu.
The top margin is 0.50”.
The bottom margin is 1.0”.
Left and right margins are 0.67” each.
These settings result in a text area on each page that is 9.5”
high and 7.16” wide.
After the paper title, authors, and key words on the first
page, two columns are established. This in accomplished in
WORD by inserting a continuous section break after the Key
Words (“Page Layout” pull down menu, select “Break”…,
select “Continuous” from Section break types).
After
inserting the section break, use the “Format” pull down menu,
select “Columns”, select “Two” columns from the “Presets”,
and enter 3.5” for the “Width” of column #1 and 0.16” for the
“Spacing” (gutter). With the possible exception of figures or
tables that span the two columns, the balance of the paper is
formatted in two columns.
The two column layout consists of:
A column width of 3.50” for each column.
A gutter (space between columns) of 0.16”.
Thus the left column begins at 0.67” and ends at 4.17”;
the right column begins at 4.33” and ends at 7.83”.
Note that when necessary, you may place figures, tables,
or photographs so that they span the two columns. To do this,
you must use the “continuous” type section break to end a two
column section and start a single column section and then use
another “continuous” type section break to end the single
column section and start another double column section. If
you choose you place items across two columns, be sure to
balance and fill the two columns that precede the item.
Note that there should be NO HEADERS and NO
FOOTERS within the paper.
Also there should be NO PAGE NUMBERS as well as
NO FOOTNOTES within the paper.
There is a 6 PAGE LIMIT to paper length. This includes
tables and figures, appendices if any, as well as the required
reference and biographical summary sections.
3 HEADINGS & TEXT
The RAMS styles contained within this document specify
single spacing for all text and 10-pt type with 6 lines/inch
(exactly 12-pt spacing). Spacing before and after each line of
text has been set at 0 in all RAMS text styles.

The text alignment is set to “justified,” which corresponds to
block formatting in all RAMS text styles. Except for
headings, tables, and figures, all text should be prepared using
these RAMS text styles.
3.1 Paper Title
Title lines – 18-pt font (3 lines/inch – exactly 24-pt
spacing). (RAMS Title Style)
The title is centered on the page, 0.5” (36 pts) down from
the top margin. This is equivalent to 1” from the top edge
of the paper to the top of the Title line.
Capitalize the first letter of each word, use lower case for
the remainder of the word. NOT ALL CAPS!
DO NOT USE BOLD or ITALICS.
The Title is limited to a maximum of 75 characters
including spaces.
3.2 Balance of Title Block
Author line(s) – 12-pt font (4 lines/inch – Exactly 18-pt
spacing) (RAMS Author Style):
Each author’s name is flush left and may be followed by
the author’s degree(s) if desired. That is, the name should
be shown as John R. Doe, PhD. rather than Dr. John R.
Doe, and Jane S. Smith, PE.
Separate each name from the employer’s identity with a
comma.
Follow this with the company or institution name - use the
short name by which the employer is generally known.
Do not include geographical references.
Key words – 10-pt type, 6 lines/inch – Exactly 12-pt
spacing. (RAMS Key Words Style)
The legend “Key Words:” is set flush left, followed by a
colon and the few appropriate key words that describe
your paper. Try to limit the number of key words to four
or five listed in alphabetical sequence.
3.3 Headings Within Paper
Major headings are centered in 10-pt upper case (capital
letters) and are italicized. (RAMS Headings Style)
Subheadings are in 10-pt italics, flush left, and upper and
lower case. (RAMS Level 2 Headings Style)
It is strongly recommended that only two levels of
headings be used.
All headings are on exactly 12-pt spacing.
An additional 6-pt spacing has been added before and
after each heading in the template Heading styles.
All Headings and Level 2 Headings are automatically
numbered.
The Summary and Conclusions Heading is not numbered.
(RAMS Summary Heading Style)
The References and Biography headings are not
numbered. (RAMS Bio & Ref Heading Style)
3.4 Text
Text is in 10-pt type (6 lines/inch – Exactly 12-pt
spacing). (RAMS Normal)
The first line of each paragraph is indented by 0.25”.

Do not leave blank line(s) between paragraphs.
Insert two (2) spaces following the period at the end of
each sentence.
If a paragraph continues after a figure, equation, bullet,
etc., do not indent that text. (RAMS Normal Continue
Style)
Do not use bold text – highlight using italics if necessary.
If the final page of the paper is a partial page, balance the two
columns by defining a section break of the “continuous” type
at the end of the paper. In many cases, this will result in two
exactly balanced columns. In some cases, the columns will be
nearly (but not quite) balanced as a result of references or
addresses. This is acceptable.
Also, do not let WORD force you to avoid “widows” at
the top or bottom of a page. The RAMS Styles have this
feature disabled.
It is emphasized that the columns should be filled.
Authors should organize their papers to use the maximum of
the available space on each page.
The “Headings” styles have “Keep with next” selected to
prevent a heading from being isolated at the end of a column.
This may result in a small amount of column imbalance.

produces extremely large files that will take a long time to
display and print. The Smooth Graphics option is usually
found in the Page Setup Dialog box in Macintosh
applications and some Windows applications.
The type of graphics you include will affect the quality
and file size of your manuscript. In general, vector graphics,
such as those produced by most presentation and drawing
packages, are electronically efficient and will not conflict with
conversions to PDF.

4 ILLUSTRATIONS
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Finally, use the tab to move the equation to the center of the
column while leaving the number at the right margin.

The person preparing your manuscript is responsible for
the effective integration of supporting graphics, tables, and
other media into your text. WORD offers the capability of
incorporating tables, figures, diagrams, and photos into a
document. To the extent possible, use the capability that
WORD provides. Here are some additional points.
Graphics should be embedded in your document.
Whenever possible and suitable, place figures and tables
within a single column.
If necessary, define a new section having single column
formatting for the figure or table.
Place a caption at the bottom of each object. The caption
is centered and uses a 10 pt italic font size. (RAMS Figure
Caption Style) The spacing of the caption is contained
within the style.
Avoid the use of bold text within all tables and figures.
If you use photographs, be sure the resolution is precise.
Generally, black and white photos work best. For
photographs, use the jpeg format.
Bitmapped images must be created using 300 dpi. For
drawings and other graphical images, use gif format.
Bitmapped images should be as small as possible: no
more than 256 (8 bit) color/grayscale, 300 dpi.
Reduce the number of display colors before making
screen shots. The majority of computer applications use
fewer than 16 colors for their menus, dialogs, etc.
Select higher resolutions only for images that a reader
will magnify. Image resolution of bitmapped images does
not increase when readers zoom in on an image.
Make sure that any text in the graphic has a minimum
point size of 8 points. Text below the minimum point size
will not be readable in print.
Do not select “Smooth Graphics.” This option often

5 EQUATIONS
Equations should be numbered consecutively throughout
the paper. They should also be centered (approximately) in
the column. Avoid extending equations across columns (like
figures) and over multiple lines. Be concise, you know you
can.
Equation numbers should be flush with the right column
margin. There are several ways to ensure this happens. One
method is to develop your equation and put a number on it as:
(t )

(1)
F (t ) e
Then, apply the RAMS Equation Number style to the number:
(t )

(t )
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This is a reasonably easy method that will work. If you have
another approach, fine – as long as the result is the same.
REMEMBER, to set the equation size in Microsoft
Equation. Use the 10-pt font for “full size” and set the size of
the subscripts and superscripts at 8 pt with sub-subscripts and
sub-superscripts at 6 pt. Set symbols at 14 pt and subsymbols
at 10 pt. The result should look like equation (1).
To complete the insertion of the equation, use the
“Paragraph” drop down menu and in the “Spacing” area,
choose 3 pt before and 3 pt after and set the line spacing to be
“At Least” 12 pt instead of “Exactly” 12 pt. Be sure to
change back to “Exactly” 12 pt for the next line of text.
6 REFERENCE FORMAT
Note the fact that several unnecessary (meaningless)
reference citations have been made in this document [3] in
order to illustrate their use. Number your references in your
paper sequentially in the order in which you cite them. In
your reference section, list the papers as shown in the
References Section - author(s), paper title in quotes, Journal or
document in italics with full publication information including
date. Use the RAMS Reference Style for your references.
This style will automatically number your references.
7 BIOGRAPHY FORMAT
Put the name and address first, in the format for an
envelope using RAMS Bio Name & Address Style. Be sure to
include the country at the end (even if USA). Do not include
Smart Tags on the addresses. (Be sure the “Label Text with

Smart Tages” box is not checked in the “Smart Tags” tab of
the “AutoCorrect Options Menu” in the “Tools” drop down
menu. Follow the address with a line containing the author’s
e-mail address using RAMS e-mail Style that will place the
lines before and after the e-mail address. Do not underline the
e-mail address. Then provide the author’s biography without
paragraph indent using RAMS Bio Text Style. Emphasize the
author’s technical aspects. Be informative so that readers will
appreciate the expertise the authors bring to the construction
of the paper. Be sure to include professional society
membership information as this is often a condition for
receiving society publication awards.
8 RAMS STYLES
Paragraph Type
Author line
Biography and Reference
Section heading
Name and address for
Biography
Text for Biography
Bulleted text
E-mail address for
Biography
Equation numbers
Captions for Figures and
Tables
Major (Level1) Section
headings
Key words in title block
Minor (Level 2) Section
headings
Regular text
Continuation of regular text
after an insertion within a
paragraph (no first line
indent)
Reference entries in
References section
Summary and Conclusions
Heading (first section in
paper)
Paper Title

RAMS Style
RAMS Author
RAMS Bio & Ref Heading
RAMS Bio Name & Address
RAMS Bio Text
RAMS Bullet
RAMS e-mail
RAMS Equation Number
RAMS Figure Caption
RAMS Headings
RAMS Key Words
RAMS Level 2 Headings
RAMS Normal
RAMS Normal Continue

RAMS Reference
RAMS Summary Heading

RAMS Title

Table 1 – RAMS Styles in Microsoft Word RAMS Template
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